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Welcome to RaceSail 

RaceSail Version 1.2.42 
 

 

RaceSail is a system for scoring a sailboat regatta. 

 

Programmed by Edward Mitchell, Copyright © 2000 

 

Introduction 

Introduction to RaceSail 

RaceSail is a system for scoring a sailboat regatta.  A regatta consists of one or more race classes.  

In each race class, boats are registered by unique sail number.  Names and addresses may be 

entered for mailing lists.  With the boats registered, scratch sheets are produced. 

Race classes can be scored by finish position or time, with PHRF, ORC-Club (Americap), 

Portsmouth or IRC handicaps.  Results are shown and can be printed.  Two or more races are 

summed and the total scores ordered into a final ranking.  Ties are broken according to the 

procedure outlined in the Appendix A of the US Sailingôs "The Racing Rules of Sailing 2009-

2012."  There is optional removal of A8.2.  Race classes with a large number of boats can be split 

into fleets and these fleets allocated to multiple starts within one race. 

The program follows the standard Windows conventions and the important ones for using the 

program are described in more detail in Windows Conventions. 

All programs are in some danger of crashing when situations not anticipated by the program 

designer occur.  The more a program is used, the more stable it is.  When RaceSail encounters an 

internal problem, there is a catcher placed in the call stack that will ask whether an attempt should 

be made to save the current data.  Since most aborts are caused by an action, not by creating 

inconsistent data, the file that is saved has a reasonable probability of working.  If the saved copy 

fails to load, it can be returned to the author for a post mortem examination.  If this identifies a 

bug, it will be fixed at the next release.  So the rule should be the following after an abort.  Select 

the save file option at the "Would you like to try and save any modified regattas?" but prior to that 

rename the current .rcw file so that you will have a backup in case the saved file is corrupt. 

As well as trying to recover from errors, it is as well to save to the disc file periodically.  Just click 

the floppy disc icon or do File>Save.  And definitely make backup copies of the .rcw files when 

they any updates are done. 

If the program crashes, it is a problem for the author.  A correctly designed program should never 

abort no matter what mistakes were made in inputting the program data.  Maybe the results will be 

incorrect but the program itself should never die!  Please report all problems.  Repeatable 

problems can be fixed for the next release. 
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Key features 

Uses standard Windows conventions for opening a regatta, saving, printing and print previewing. 

Scratch sheets show the minimum digits (or characters) of a sail number to be unique within the 

race class. 

Generates HTML files for posting the results to a web site. 

Can automatically send the files to the web site without scorer knowing HTML coding. 

Ties are broken by count of firsts, seconds, thirds, etc.  If still tied, they are broken by score in last 

race. 

There is an ICSA (Inter-Collegiate Sailing Assoc.)  flag that will add a tie break on who-beats-

who the most. 

Bow numbers that can be rotated up/down and interleaved for round robin boat switching. 

Unlimited number of races, divisions and boats. 

Series scoring options for races stretching over time. 

Overrides of scores via RDG and averages over all races or just races sailed. 

Averages that can compensate skippers when serving on the race committee. 

Right click context menu for quicker selection. 

Break large classes into fleets that can be allocated to starts. A full round robin sequence can then 

allow each boat to have an opportunity to sail against every other boat in the fleet. 

Designate some races as qualifying with separate discard rules. 

Compliant with ISAF modifications to Appendix K for large race classes. 

Series results can be grouped and so frozen against modifications to the number of competitors or 

discard schedule. 

Segment times can be summed to create a single race from individual segments. 

Division times can be adjusted to compare boats sailing different distances. 

System Requirements 

RaceSail requires at least: 

Ç Windows 95, 98, 2000 or XP. 

Ç 32 MB RAM or more. 

Ç At least 32 MB free disk space. 

Ç Monitor with screen resolution set to at least 800x600 

Basics of RaceSail 

This section describes how to enter the data for a regatta, score the races and then produce printed 

output and HTML files that can be posted to the club web site.  There is some confusion over the 
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meaning of Divisions and Fleets.  In RaceSail, Divisions are the subgroups for which prizes are 

awarded.  Handicap bands, gender, age, boat subtype.  Fleets are a subgroup of a large race class 

that can be raced against each other.  As an example, consider a race class of  120 Lasers.  

Allocate these to four fleets, Red(R), Blue(B), Green(G) and Yellow(Y), 30 boats in each fleet.  

Two Starts containing 60 boats are created with R+B, G+Y. Next race, the fleets can be reassigned 

as R+G and B+Y.  The full round robin is obtained in the third race of R+Y and B+G.  Boats can 

be reassigned to fleets in the evening so that there is a different mix for the following day. 

The general sequence is as follows: 

Ç Create the regatta by specifying the name and date - Create Regatta. 

Ç Enter the race classes that are going to be scored in the regatta (at least one) - Create Race 

Class. 

Ç Enter any divisions that are used in each race class (optional) - Enter Divisions. 

Ç Enter any fleets if a large race class is to be broken up into separate starts (optional) -  

Ç Register the boats in each race class - Register Boats. 

Ç Create a race. Timed races need starting times and maybe distances - Create New Race. 

Ç Possibly rotate bow numbers ï Rotate Bow Numbers  

Ç Print scratch sheets - Preparing Scratch Sheets. 

Ç Enter results as reported from the committee boat for each race - Enter Finish Information. 

Ç Score and print the results for each individual race - Individual Race Results. 

Ç Score and print each race class overall result ï Overall Scores. 

Ç Print any results to an HTML file for uploading to your web site ï Print HTML File. 

Ç Save the boat information to the archive database so can be used next year ï Save to Archive. 

Ç Merge a regatta so that races are appended at the end of the matched race classes - 

Tools/Merge. 

Ç Freeze a series overall score into a group and optionally edit the scores ï Group Races.  

Ç Copy selected parts of a regatta to the clipboard so that these can be pasted into another - 

Edit/Copy. 

Using RaceSail 

Creating the Regatta 

Create a Regatta 

Create a new regatta by selecting New from the File drop down menu.  In the dialog box that is 

popped up, enter in the name of the sponsoring authority, if any, the name you want to give to the 

regatta, the Web Site URL, the Burgee Image File, the email address and the name of the race 

officer, if any.  An expanded description can be given that can include more officers, location, 

class association, etc.  Add anyoneôs name associated with the event. This text will be added to the 

final printout, centered on the line. You can add as many lines as you like here with the proviso 

that you are using up real estate on the final printed page.  Blank lines are fine and add white space 

the output.  Use the Enter key to move to a new line in this edit box.  Also select the regatta date.  

This date will not be listed anywhere since we found that it was confusing to sailors who wanted 

to know which result list was the most up-to-date.  It is used as the default date for the start of the 

first race within a race class.  Subsequent races have a default start date the same as the 

immediately previous race.  If the Burgee image file is to be referred to on a web site, donôt 

browse for a file name, make sure that it is the actual URL of the image file.  A local file can only 
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be displayed on the computer that is used for the scoring.  Since the results are usually destined for 

a web site, the image has to be accessible as a URL from that site, not a file on the computer, 

which is doing the scoring. 

  

Clicking on the down arrow of the date control will open up a date selector showing a complete 

month as shown in the following fragment from the dialog box.  The month can be changed by 

clicking on the small left and right arrows at the top of the date box.  An easier switch is to click 

on the year and this will change to an edit box with spin buttons that can be clicked to increment 

it.  Click on the month and this will show a drop down list of all twelve months from which you 

can select the correct one. 
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. 

The sponsoring authority text and the regatta name will appear on the top of all the print out of any 

results.  The web site information will appear in an optional file when the results are saved 

(File>Import/Export>File Save Resultsé) The race officerôs name will appear at the bottom of 

any printed results. The default name for the regatta will be Regatta_n where ónô is a digit 

corresponding to the number of regattas created. You should normally override this name to 
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something more in line with the actual regatta you are going to be running.  You will get the 

opportunity to change this when you do a File/Save or a File/Save Asé 

Clicking the OK button from this dialog box will create a window with a tree view on the left and 

an empty list view on the right.  The only thing in the tree view will be the open book icon that 

will contain the regatta information. 

 

Create Race Class 

The next task is to create race classes within this regatta (such as Lasers, Optimists, Ocean 

handicap, etc.).  Do this by selecting Add Race Classé from the Regatta drop down menu.  This 

menu item will popup the Enter Race Class dialog box as follows. 
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If any classes are available in the archive list, their names will be shown in the drop down combo 

box labelled Class Name.  Using an existing class will greatly speed the boat registration if most 

information on boat and skipper can be retrieved from the previously entered information.  If none 

are suitable for this class, then just type in a new name. It may be necessary to use a name that is 

different from the actual race class in the archive list.  However, you would want to draw all the 

boat information from the same archive database.  In this case, enter a separate name for this class 
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and select from the drop down combo box labelled Archive Database Class the actual race class 

from which the boat information will be extracted when the sail number is given. 

Boat information can also be readily imported from a .csv file prepared from a standard spread 

sheet program such as Excel or a data base program such as Access. 

Next select the scoring method (tab to the control) by opening up the selection by either clicking 

on the down arrow or using the down arrow key.  The choices of scoring methods are as follows: 

One design (Finish Position)  

One design (Finish Time)  

PHRF (Time on Distance)  

PHRF (Time on Time)  

ORC Club (or Americap) (Time on Time&Distance)  

Portsmouth  

IRC (Time correction factor)  

Pursuit  

 

These are described in more detail in sections immediately following this one. 

Continuing with the "Enter Race Class" dialog box, add a description if you want to put more text 

into the printed output.  In this you could put an expanded event name just for this race class 

(National Optimists), the class association and contact information, etc.  This text will be added as 

a separate line or lines to the print out.  As for the Regatta description, you can add as many lines 

as you like, entering them into the edit box using the Enter key for a new line. 

The usual selection for one design is the finish position where boats are recorded in sequence as 

they cross the finish line.  There is a provision for indicating a tie, when the difference between 

boats crossing times is too close to call.   

Now set the nominal drop percent and separately, the maximum value for the drop count in any 

qualifying races and in any final races.   Races can be marked Qualifying when creating a new 

race.  The default is that all the races are part of a final series.  A numeric value can be typed 

directly into the boxes or else clicking on the small spin control arrows will change the value in 

whole numbers.  If you choose a drop of 20%, then in an eight-race regatta, there will be one 

discard  taken.  The integer drop count is obtained by rounding down to a whole number the 

product of the number of races by the drop percentage, expressed as a fraction. It is then compared 

with the maximum drop count and the lower one chosen. The RRS state that in a series, the worst 

score is to be dropped so the default numbers are 20% with a maximum of one drop.  This means 

that up to four races will have no throw outs. Once the number of races equals or exceeds five then 

one drop will be allowed. 

Next, choose whether boat names will be entered.  For one design, boat names are usually 

eliminated.  If checked, this can use up valuable space on the printed result sheets and of course, 

the boat names have to be typed in from the registration sheets. 

The last check box is for bow numbers.  These are integers that are associated with a boat. 

Conventionally they were used to reduce the number of digits that had to be recorded as boats 

crossed the finish line. Now however, they can be used to swap boats in a round robin series.  The 

reason why the check box is at the Create Race Class level is that when the boats are being 

registered (entered into the race class,) every boat must be given a bow number that is unique.  

These can be specified for each boat or else the program will assign each boat to the lowest unused 

value. 

Remember that once bow numbers have been chosen for a race class, this, like the Scoring 

Method, cannot be changed.  Boats and results can however be copied to the clip board and pasted 

into a new race class.  If the new race class doesnôt have the bow number checked, the pasted 
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boats will have their numbers removed.  Boats pasted into a race class that is using bow numbers 

will have the bow numbers filled in with the smallest integer that is unique within the class at the 

time when the actual boat with the pasted group is inserted. 

 

One Design, Finish Position 

Boats are recorded in sequence as they cross the finish time. Enter these directly even though 

some may be disqualified or retired.  The boats can be sorted on this order and printed for 

checking against the written sheets and also from tape recordings of the finish. 

 

One Design, Finish Time 

Very rarely used.  Times are recorded and the boats are scored from the recorded time.  Since 

there is no correction applied, the rank order is the same as the order in which they cross the finish 

line. 

 

PHRF, Time on Distance 

For handicap races, the usual method is to take the PHRF rating in seconds per mile and multiply 

this by the race distance in nautical miles to obtain an allowance that is subtracted from the final 

measured elapsed time to give a corrected time.  Boats are then ranked on this corrected time. 

 

PHRF, Time on Time 

PHRF with time on time will have a correction factor computed from the formula: 

 A/(B + PHRF) 

where the constants, A and B can be chosen in the Preferences section. Typical values are 700 for 

A and 550 for B.  With these numbers, a PHRF value of 150 will result in a multiplier of exactly 

1.0.  PHRF values below that will increase the time, PHRF values above will see their time 

decrease.  The A and B coefficients can be changed by the Edit>Class Optionsé Score tab for the 

class.  These coefficients apply to all races with the class. 

 

ORC Club (Americap) 

ORC Club (Americap) is a new handicap system that uses two numbers to determine the 

correction.  The corrected time is obtained by the following formula: 

  CT = ET*PLT ï d*PLD 

Where ET is the actual elapsed time that the boat took over the course, CT is the corrected time, d 

is the total distance around the course in nautical miles.  The ORC Club coefficients PLT and PLD 

(Americap A and B) are obtained from a certificate which will define six different course types, 

one of which must be chosen prior to the race start.  Boats are ranked on the corrected time. 
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Portsmouth 

Portsmouth handicap is implemented by computing a correction from the formula: 

 CT = ET*100/DPN 

The DPN value will be chosen based on the wind speed or an estimated Beaufort number.  These 

Portsmouth numbers are entered when the boats are being registered.  Wind speed is set when 

each new race is created or edited.  The following table shows the correspondence between wind 

speed set (in knots), Beaufort number range and the index of the particular DPN number 

corresponding. 

  Wind Speed Beaufort Range D-PN index 

  0  0  1 

  1 to 3 knots 0 to 1  2 

  4 to 10 knots 2 to 3  3 

  11 to 16 knots 4  4 

  17 knots or more 5 and up  5 

The index in the last column, corresponding to the wind velocity, will determine which of the five 

Portsmouth numbers given in the boat registration form will be used. If a Portsmouth number for a 

particular wind speed is not available, them the value at index one will be used.  This change is 

done with no warning so make sure if you are using wind dependent values that all the numbers 

have been filled in.  The value used in calculating the correction factor will be shown in the results 

column when a specific race is selected. 

 

IRC 

IRC is a simple multiplier to the elapsed time. The corrected time is given by: 

 CT = ET*tf 

where tf is the IRC time factor. 

 

Pursuit 

Pursuit is for PHRF races with a defined distance.  After creating a race with a given distance, 

starting times for each boat are calculated by subtracting the handicap time from the race start 

time. On this basis, if all boats sail to their handicaps, they will cross the finish line 

simultaneously!  One advantage of this handicap rule, is that the order of finish is the same as the 

final standing.  Corrected time is calculated in exactly the same way as for the PHRF, time on 

distance. It is the elapsed time calculation that differs since most boats will have separate starting 

times. 

If you want the race to start at a particular time for the slowest boat, set the race start time so that 

this time minus the slowest boats allowed time is the start time you want.  As an example,  the 

slowest boat has a handicap of 210 seconds/mile.  The race distance is 19.7 nm and you would like 

the first boat to start at exactly 1000 hours.  The distance times the handicap is (19.7 times 210) is 

4137 seconds or 1 hour, 8 minutes, 57 seconds.  Set the race start time to 11:08:57 and the first 

start time will be ten oôclock exactly. 
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If it ever becomes necessary to shorten the course while the race is underway, make sure that the 

"Keep Start Times" box is checked in the Edit Race Info é dialog box. 

If you want to sum elapsed times for a series of races using Tools>Sum Race Times... , you will 

have to start off with zero distances in order to get the starting times correct.  See Pursuit Race 

Times Summation  

 

 

Enter/Change Any Divisions 

Next comes entering any divisions in the race class.  First, choose the race class in the tree view by 

clicking on the race class icon.  Until the race class is selected, the "Enter/Change Any Divisions" 

menu item under the Regatta menu will be greyed out.  With a race class selected, choose this 

Enter/Change Any Divisions, which will show the following popup dialog box. 

  

Enter the division name (Juniors, Masters, Blue, Red, A, B, etc) in the edit box below the New 

Division.  If the race is not a handicap race, the Low and High Handicap controls will be greyed 

out since it is irrelevant in this case.  The dialog shown is for a handicap class Ocean, which has 

three classes, A, B, C and Seniors.  Divisions A, B and C have a start time and distance associated 

with them.  Seniors is just a division that can be scored independently with maybe separate prizes 

being awarded.  The break for the different handicap divisions is obtained by entering the low 

handicap value for the range.  If the handicap bands are contiguous, you just have to enter the low 

value and then push the Adjust Highs button, which will run through and make the high values 

one less than the low value of the class above.  Otherwise there is no requirement that the ranges 

donôt overlap.  For instance, division C could be a non-spinnaker class that extends from zero to 

9999.  The number of boats currently assigned to the division will be listed in the last column.  

When boats are assigned to divisions, a specific boat can only be in one division that has a start 

time. 

Once some text has been entered into the division box, the Add button will be enabled.  If you 

want the division to be associated with its own start time and/or distance, make sure that the check 

box is ticked.  Then push the Add button and the division name will be transferred to the division 

list box and the division name will be cleared.  If you make a mistake, select a row in the list box 

from the already entered names.  This will enable the Remove button and if this is pushed the 

division will be deleted.  In addition, the Add button will change to a Change button in case the 

name or the handicap values are to be modified.  If we are changing the divisions of an already 
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created regatta, there is a warning issued if any boats have been entered into the division about to 

be deleted. 

In this dialog box, the division names are accumulated in the list control and no action is actually 

taken to create the divisions until the Done button is pushed.  If you change your mind about 

creating any divisions, hit the Cancel button and no permanent action is left around. 

The exception to the above is the "Assign Boats" button.  This button will clear all the division 

assignments for this race class and then run through all the boats, assigning them to the division 

into which the boat handicap falls.  Once this has been done, there is no going back.  The intent of 

this button is so that different division bands can be tested for balance and so that you can avoid 

the situation where 90% of the boats are in division B and the other 10% split between divisions A 

and C. 

This dialog is also used to edit any of the division names or attributes.  Select the division in the 

right-hand list box and the Add button will change to a Change button.  If you donôt want to 

change a division, click anywhere in the list box and the selection line will disappear. 

 

Enter/Change Any Fleet 

If you have a very large race class, now is the time to consider breaking in up into fleets.  Each 

start then will be of one or more fleets, so reducing the number of boats crossing the starting line 

together. You donôt have to define the fleets before the boats are registered, as there are ways to 

assign blocks of boats after the registration has been completed. In fact, it can be easier to do a 

random assignment after all boats are registered rather than by doing the assignment of each boat 

separately.  In order to enter the fleets, a race class must be selected in the left-hand tree view. 

Until then, the "Enter/Change Any Fleetsé" menu item will be greyed out.  With a race class 

selected, choose this Enter/Change Any Fleets, which will show the following popup dialog box. 

  

When the dialog box opens, any existing fleet assignments will be shown in the list box.  The new 

fleet combobox is used to enter a fleet name.  The combobox is preloaded with colors but any text 

string can be used for a name.  With something defined in the New Fleet control, the Add button is 

enabled and pushing this will add the name to the list.  If you make a mistake, select a row in the 

list box from the already entered names.  This will enable the Remove button and if this is pushed 

the fleet will be deleted.  In addition the Add button will change to a Change button in case the 

name is  to be modified.  If we are removing fleets from an already created regatta, there is a 

warning issued if any boats have been entered into a fleet about to be deleted. 
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In this dialog box, the fleet names are accumulated in the list control and no action is actually 

taken to create the fleets until the Done button is pushed.  If you change your mind about creating 

any fleets, hit the Cancel button and no permanent action is left around. 

The exception to the above is the Rand Assign button.  This button will clear all the fleet 

assignments for this race class and then run through all the boats, assigning them at random to the 

different fleets. 

Fleets are different than Divisions in that the fleet information for a boat is kept with a race. Once 

a race is created, the fleet assignments are copied into the race record.  Changing the fleet 

assignments using the Enter/Change Any Fleets menu item, wonôt affect any existing races.  This 

is important since you donôt want existing scores to change just because there is new fleet 

assignment.  Fleet assignments to a specific race can be changed using the Fleet Assignment é 

item under the Edit menu but a warning will be issued to confirm that you really want to make the 

change.  A fleet assignment can be modified for a single boat by selecting the race and the boat 

and then choosing Edit Boat Info é  If you donôt want to change previous results, make sure that 

the race class alone is selected in the left hand tree view, not any race. 

 

Register Boats 

Once the divisions have been entered, then comes the lengthy task of registering the boats in the 

selected race class.  If the boat information is available in a .csv (comma separated variable) file 

with the appropriate column headers, then it is possible to import all the boats information into the 

race class via the File>Import/Export>Load Boat Info. . . .  This could be a considerable time 

saver. 

 In order for the Register Boats item to be enabled under the Regatta menu, a Race Class must be 

selected in the left-hand tree view so that the program knows where to store the boat information.  

Selecting this menu item brings up the following fairly complicated popup dialog. 
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The only requirement for this dialog box is that the Sail Number must be entered.  The Sail 

Number must be unique within the race class.  If there is an archive race class of the same name, 

then all the sail numbers from this class (and the race class with a blank name ï see Archive Edit 

later) will be in the Sail Number drop down list box.  Typing a sufficient number of characters of 

the sail number will allow the sail from the archive to be highlighted. 

There is two other checkboxes that affect the sail number drop down list.  These are on the right 

middle and are labelled "Show Skipper" and "Show Boat Name."  If there are no boat names in 

this race class, the "Show Boat Name" check box will be hidden.  If these are checked, then the 

drop down list of archived boats will be expanded to either two or three columns showing the boat 

name and/or skipper name alongside the sail number. This makes choosing a sail number easier 

when it is needed to match a registration entry form. 

If there is a highlighted sail number from the archive, then the action of changing focus from the 

sail number combo box will fill in the rest of the fields with the corresponding information from 

the archive boat.  You would normally change the focus by hitting the tab key which will change 

the input bar symbol to the next field.  Just clicking on one of the other fields will also accomplish 

the same thing. 

If there is no match, then any text can be entered into the Sail Number box.  Try to use numbers if 

possible and donôt use the USA prefix unless you really have international competitors.  The 

sorting of sail numbers is a little different if they start with a letter, so for a consistent look to the 

printed output, try to use plain numbers.  However in a pinch, "Brown" or "Torn" would be 

acceptable to the scoring program (as long as the text is unique.)  Try to avoid white space in the 

sail number.  Since others may not be able to enter the white space in the same way, it will be 
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removed before the boat information is saved away for use when scoring.  The sail number is case 

insensitive so "Brown" is considered the same entry as "brown". 

A Bow Number can be entered if the race class had the Use Bow Numbers box checked.  The 

suggested number here will be the next one in sequence after the last boatôs number.  If the race 

class is not using Bow Numbers, this box will be disabled. 

The yacht club can be entered into the combobox or else selected from the drop down list.  If the 

chief scorer has edited the yacht club list via the Preferences menu item, then the spelling and 

abbreviation will be more consistent. 

A birthday can be entered that will show up in the race class list of boats.  Sorting on this entry 

then will allow rapid assignment of boats to divisions based on age.  If the box is opened up and a 

date is selected, then the way to get rid of this is to uncheck the box that sits inside the time 

control and only appears when a valid time is also present. 

A nation can be chosen from the drop down combo box.  This is a three letter abbreviation such as 

CAN, USA, GBR, etc.  The list can be extended from the Nations tab under the File>Preferences 

menu item. 

If the skipper and/or crew have ISAF numbers, then these can be entered here.  An entry in these 

fields will produce a link in the HTML results to the ISAF web site that will give more 

information on the sailor.  If there are more than one crew persons, enter all the names in the last 

name field.  Provided there is no entry in the first name field, then the text that is entered into the 

last name will be maintained. For two people use "Joe Smith, Mary Jones" (without the quotes) 

and this text string will appear in the listing wherever the crew is listed. 

If the scoring method was One Design (Finish Position) or Portsmouth, then there is room for one 

crew member.  This will be an extra set of four fields at the bottom right for first name, middle 

initial and last name and just above, the ISAF number.. 

The rest of the dialog box is straightforward except for the divisions.  It is at this point that the 

boat has to be told what divisions it is going to sail in.  A boat can be in more than one division 

(Blue, Men, Women, Old, Young, etc.) 

The divisions are selected from the drop down list box.  Once a division is highlighted, then the 

arrow (>) button is enabled that will move this into the list of selected divisions, automatically 

removing it from the original selection so that it canôt be added twice.  This is shown in the 

following enlarged view of the Register Boat dialog box. 

  

If a division is added by mistake, select the row in the list control at which point the left arrow 

button (<) will be enabled.  Pushing this will move the division back to the original list. 

If the race class is a handicap race, then the divisions are usually assigned based on the handicap 

value.  It is much easier to use the Enter Divisions dialog to adjust the handicap breakpoints rather 

than entering the division for each boat.  PHRF races will have a separate edit box for the boatôs 

PHRF handicap as shown in the dialog above.  In addition the separate menu item Edit/Division 
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Assignmenté can expedite wholesale assignment of divisions.  This menu item will only be 

activated when you have made a selection in the list view of boats. Remember that you can select 

multiple boats by a combination of Click, Shift-Click and Control-Click or you can select them all 

via Edit>Select All.  These selected boats can be assigned and deassigned from the defined 

divisions as a group.  Sort on birthdays and then the Optimists can easily be assigned to the 

appropriate division (Optimists call these fleets - red, blue, white, etc.) 

If the boat name box was unchecked in the definition of the race class, then the boat name field 

will be missing from the above. 

The boat number being entered into the selected race class is listed at the top of the register dialog 

box so that the current number of boats in the class can be determined.  In the list view of the 

boats, there is a status box at the bottom that will show the total number of boats that are in the 

list.  This is useful for counting lunches! 

Three fields that can be any text strings are Custom1, Custom2 and Custom3.  Entries here are for 

maintaining information about competitors. The text of Custom1, Custom2 and Custom3 will be 

listed as a separate column in the scratch sheets and results columns.  If nothing is present in the 

columns, these headers are eliminated.  Use these for such things as Fee Paid, Signature on File, 

etc. 

If the race class is a handicap class, then the appropriate boxes will appear.  PHRF will have one 

integer edit box;  ORC-Club (Americap) will have two edit boxes for the performance line PLT 

and PLT coefficients (Americap has A and B coefficients);  IRC will have one edit box for the 

time multiplier; Portsmouth will have five edit boxes for the wind dependent Portsmouth 

coefficients. 

For Portsmouth scoring, the wind speed in knots is shown over the boxes that determine the D-PN 

values. The following figure shows this. 

  

There is one other box that requires explanation.  This is the Handicap Change.  Sometimes a boat 

will have a PHRF handicap that assumes that the boat is flying a spinnaker.  If for this race the 

skipper decides that they want to race under the cruising rating, the adjustment can be made here.  

Say that the racing PHRF is 154 and the cruising PHRF is 160.  For a nominal racing boat the 

PHRF box would contain 154 and the Handicap Change box would contain 6.  If the boat is 
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normally entered into the cruising class and for this race it is flying a spinnaker, the PHRF box 

would contain 160 and the Handicap Change would contain ï6.  the change can be negative or 

positive.  For the other handicap systems, this Handicap Change box will be added to the handicap 

actually in use.  In the case of the ORC-Club (or Americap) system, which has two handicap 

numbers, PLT and PLD, the Handicap Change value will be added to the PLD coefficient.  The 

PLD value is similar to the PHRF integer in that is has the units of seconds per mile. 

This Handicap Change box will show up when editing a boats information for a series.  Someday 

the boat will sail to the racing handicap and some days it will sail to the cruising handicap.  This 

handicap change is remembered inside the race so a boat can have different handicap values 

throughout a series.  The value that you see will depend on which race is selected.  If no race is 

selected, the value that you see will be used when another race is created. 

Hull color must be selected from one of the following: White, Black, Red, Orange, Blue, Yellow, 

Brown, Green, and Grey.  The reason for restricting the choice is for consistency in that the more 

esoteric colors can have differing names and mean different things to different people.  You can 

add to this list if you want a wider choice through the File/Preferences dialog box. 

Spinnaker color is also selectable from the same list as hull color but if that doesnôt suffice (may 

be Blue/Yellow Stripe), any text can be entered into the field.  Just remember that extended text 

will widen the column in the scratch sheet and may take up too much real estate on the printed 

sheets. 

Once all the information for the boat has been entered, click on the Enter button and this boat will 

be added to the class.  All the fields will be cleared and the focus will be set back to the Sail 

Number field, ready for the next boat.  Once all the boats (or however many for which information 

is available) have been entered, click on the Close button to dismiss the dialog.  

 

Create New Race 

With the boats all registered, itôs time to run the race and score the result.  For one design, the 

New Race item under the Regatta menu will create a new race which will show up as a node in the 

tree under the selected race class.  In order for the New Race menu item to be enabled, a race class 

must be selected.  Selecting this menu item will result in the following popup dialog.  If the race 

class is not timed, the list of divisions will be disabled.  For a timed race, the race start time for 

each division (marked as associated with a start time) can be entered. 
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At the top you can change the date and also enter a race name, a wind speed and select a wind 

direction.  If these fields are blank, nothing will appear on the printed output page.  If the scoring 

method is Portsmouth, then the wind speed (in knots) entered here will select the appropriate D-

PN value from the values entered when the boats were registered.  If the race name field is left 

blank then a default name of Racenn (i.e. Race10) will be used for the tree nodes and Rnn (i.e. 

R10) will be used for the race results columns in the Overall view.  If you want to identify races, 

you can enter the names in the Race Name edit box. I.e. Choose July4-R1 or Aug2-R4.  Wind 

direction can be selected from the cardinal points (N, NNE, NE, ENE, etc.) or entered as a text 

string for the bearing.  If you give a bearing itôs conventional to always use three digits. Use 025 

rather than 25. 

Separately a description of the race can be entered in the next edit box.  This description can be as 

many lines as you like.  Use the Enter key to move to a new line.  Text here will be listed under 

the race number and date if you choose to print a single selected race results..  

Only divisions that have a start time or distance will be listed.  Each row may be selected when the 

elements will appear in the Start Time and the Distance (Nm) edit controls.  They can be changed 

and then pushing the Apply button will transfer the new values back to the original list.  Note that 

if when you created divisions and did not check the "Has Start Time and/or Distance" box, then 

the division will not be listed here and you wonôt be able to set a separate starting time and/or 

distance.  Go back to the Regatta>Enter/Change Divisions é dialog, select the division, check the 

"Has Start Timeé" box and then push the Change button. 

An untimed race would not normally have the starting time listed but if you need this on the final 

printout, activate the time entry by clicking on the check box inside the Start Time control.  

Similarly for distance, if you want the distance to show up on the output, make it non-zero.  If the 

distance is zero, then no value will be printed. 
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There is also space for comments the Race Committee may want to add to the printout sheets.  

Such things as "Course shortened at fourth mark,"  "Race Abandoned," "Sail numbers nnnn and 

nnnn report to RC."  As for the descriptions, this edit box can have as many lines as you like. 

Checkboxes can designate the new race as qualifying which will affect the discards allowed and 

the tie breaker algorithm.  Cosmetic check boxes are used to document that the race was started 

under the I Flag or Black Flag rules.  This will be listed on the printed output for the race.  You 

can also specify that this race can not be discarded.  The default is that all races may be discarded 

so the checkbox will normally be checked. 

The new Olympic scoring applies a double weight to the last race of the series and specifies that 

this be non-discardable.  In this case, change the weighting number in the "Race Weight" edit box 

to 2.0 and remove the check from the "Discardable" checkbox. 

At the end, pushing the OK button will complete the creation of the new race. 

If you have defined fleets so that the starting line can be reduced, the next thing is to create a Start 

for selected fleets.  If you have two starts, then there will be two firsts, two seconds, etc.  Without 

fleets, go to Enter Finish Info é 

A race with no boats scored will have every boat marked as DNC but the scores will be set to zero.   

This is so that a race can be abandoned without changing the overall count of races.  The final 

score will also be unaffected.  With the normal penalty of DNC being number of registrants plus 

one, abandoned races could affect the overall score and more significantly, the discards if any are 

allowed. 

To speed up the creation of a new race, there is a button on the toolbar that can quickly open the 

dialog box. 

 

Create New Start 

If you have any fleets defined and there is a race selected, then the "Create New Starté" menu 

item will be enabled under Regatta menu. Selecting the menu item will result in the following 

popup dialog. 
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Starts contain fleets and are designed to reduce the number of boats crossing the starting line at the 

same time. Boats assigned to a start will be scored independently of any other start so that a race 

may have more than one first, second, third, etc. The information in the start dialog is virtually 

identical to the race dialog. The exception is the Select Fleet combobox and the Selected Fleets list 

box. To assign a fleet, select from the ones unassigned and then hit the > button to transfer the 

fleet name to the selected list. If you make a mistake, select the fleet in the list box and hit the < 

button to move it the other way. Assume that we have four fleets ï Brown, Orange, Pink and 

Yellow. We have assigned these randomly among 120 boats so that there are 30 boats in each 

fleet.  When we first create a start the dropdown combobox will contain Brown, Orange, Pink and 

Yellow.  Assign Brown and Pink to start number one. When the next start is created, the 

combobox will list the unassigned fleets, Orange and Pink. Assign those. Now we have two starts 

of 60 boats in each.  When the race is run, two starts are signaled. Boats start and finish usually 

over the same finish line but possibly over two or more finish lines.  Record the finish sequence 

(and finish times if for a timed race class) and then enter the results by selecting the Enter Finish 

Info é item under the Regatta menu. If you have more than one finish line, just list the boats 

across one finish line after the other.  The important information is the relative order of the boats 

within a start.  As boats are entered, they are assigned to the correct start and scored relative to the 

other boats in that start. 

If separate starts have been created under a race, the tree view will show this as shown in the 

following figure. 
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Under Race1 are listed the divisions, White, Blue, Red and Green, and also the starts, 

Brown|Yellow and Pink|Orange.  Selecting these nodes in the tree will show the corresponding 

boats that are in that particular start in the right hand list view. In the Figure, the results for the 

race are shown and the two firsts, two seconds, etc. can be clearly seen. 

Rotate Bow Numbers 

Rotate bow numbers will be enabled if the race class itself has been created with the bow numbers 

box checked.  In addition a race must be selected in the left hand tree view.  Selecting this menu 

item will popup the following dialog box: 

  

The action is here to change all the bow numbers so that sailors can be reassigned to different 

boats.  The default assignment when a race is created is the bow number entered when the boat 

was entered or last edited.  To change this, the numbers can be rotated through the fleet.  The 

rotation can be up, down or a split with half going up and half going down.  The split can only be 

chosen with an even number of boats. 
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The simplest rotation is one that goes up one boat.  Bow numbers for skippers A, B, C, D are 

initially 1, 2, 3, 4.  After rotating up through one place, A will be in boat 4, B will be in boat 1, C 

will be in boat 2 and D will be in boat 3.  Rotating down will go the other way. 

The split can rotate evens up, odds down or evens down, odds up.  If the choice is Rotate 

Split/Odd up, the above base assignment of A, B, C, D starting with 1, 2, 3, 4 will be changed to 2, 

1, 4, 3 for a different way of mixing up the boats.  When you choose the split, the number of odd 

numbers must equal the number of even numbers. If this is not so, even though the total number of 

entries is even, a message box will be popped up to complain and the operation will not be 

performed.  There is no requirement that the actual bow numbers be contiguous. 

 

Enter Finish Information 

Once the new race has been created, then the finish information can be added.  Selection of the 

Enter Finish Infoé from the Regatta menu item brings into being the following popup dialog box.  

This is for a timed race, which requires specification of a finish time for each sail number selected.  

This Enter Finish Infoé dialog box will only be enabled when a race node is selected in the left-

hand tree view.  That is, you must choose which race is to have the finish information entered. 

  

The sail number for the boat is selected from the drop down list box.  This will display all the sail 

numbers entered into the race class.  As boats are scored, then the sail numbers are moved out of 

the Sail Number combo box and into the list of scored boats.  Thus, the list of unscored boats will 

get progressively shorter, making it easier and easier to find the boat being scored.  Itôs usually 

much quicker to enter the sail number characters from the keyboard.  If you enter sufficient digits 

to select one of the sail numbers, then the rest of the number will appear and you can tab from this 

to the next field.  Numbers can be entered from the numeric keypad and the "Enter"  key is 

equivalent to pushing the default "Enter" button to record the result. 

As an aid to entering the correct number, you can choose from two check boxes on the bottom left 

of the dialog box, "Show Skipper" and "Show Boat Name."  This will expand the information in 
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the sail number drop down box so that both the skipper and boat name, if used, will be shown.  

The following figure shows how this appears. 

  

The extra information helps the scorer identify a boat that may have only part of the sail number 

written down and even parts of that may be incorrect. 

Another way of entering sail numbers is to enter them backwards.  The scratch sheets identify how 

many unique digits are necessary to record (reading from the right.)  Low order digits have more 

variability than high order digits since the thousand or ten thousand digit doesnôt change every 

year.  Entering the sail number in reverse order matches the recorders written information of the 

last so many digits in the sail number.  As an example, assume that sail number 612345 and the 

last three digits are sufficient for uniqueness.  This 345 is what is written down.  Now enter the 5, 

which will show on the line with the caret, showing where the next character is going to be 

inserted, behind (to the right) of this digit. Now enter the 4.  The line reads 45 with the caret in 

front of the 4.  The next digit is the 3, forming the 345 and since this is unique in the unscored 

boats, the dropdown list will open up and the 612345 will be highlighted to confirm the sail 

number entry.  Of course if the 45 part is sufficient for uniqueness, then the complete sail number 

will be shown when the 4 has been entered.  Use this entry method if for a Laser Class.  The Class 

Association recommends only recording the last four digits of the sail number as the boat crosses 

the finish line.  Entering the resulting number from left to right means that you never have to deal 

with the high order digits.  The program will identify them automatically. 

Once a sail number has been found, the Finish Condition and Finish Time can be selected or 

entered.  Move to the Finish Time and enter the finish time and push the Enter button, which will 

add the boat to the list of scored boats.  In entering the time, use the left/right arrow keys to move 

from hours to minutes to seconds and back. The up/down arrow keys will increment or decrement 

the selected field.  The time can be entered as hh.mm.ss using a period as a field separator. The 

highlighted field will show  where the next character will go so itôs possible to just enter minutes 

and seconds (mm.ss) if the highlight is on the minutes field.  It can also be done using only the 

numeric keypad. If the last field to be entered was the seconds, the minutes field will be 

highlighted for the next boat by an internally generated left arrow key character. Most times the 

information can be entered as just minutes and seconds (as in 24.33), only occasionally moving 

backwards to advance the hour. 
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If a boat is entered in error, select the row in the list of scored boats, which will enable the 

Unscore button.  Push this and the boat will be removed from the list and added back to the list of 

unscored boats in the dropdown combo box.  The "Enter" key will always act as a push of the 

default button, the one shown with a black outline.  In this case this is the Enter button so instead 

of moving the mouse over to the button, just hit the "Enter" key. 

If you notice an error in a boat that has been scored some time ago, you donôt need to unscore all 

the boats back to the one in question.  When you finish scoring, you can select the boat with the 

incorrect score and select the Edit>Finish Infoé  This will allow the finish position, finish time 

and finish condition all to be modified. 

Some boats will not finish (DNF), be disqualified (DSQ) or have a number of reasons not to be 

scored.  In order to handle these boats, select the finish condition from the Finish Condition drop 

down.  If there is a yellow flag select the SCP (scoring penalty.)  For a Z flag penalty, select the 

ZFP condition.  SCP or ZFP penalties will, by default, add 20% of the registered boats (rounded to 

closest integer, 0.5 rounds up) to the rank of the penalized boat.  In no case will the score of the 

penalized boat be made higher than a DNF (Did Not Finish) boat in the same race class.  In the 

rules it is possible to have more than one SCP or Z flag penalty.  In the program, only one 

condition can be selected for each boat.  If a larger penalty is desired, use the RDG (Redress 

Given) condition by selecting the Edit/Override Scoreé when the boat row is selected in order to 

enforce a different score.  Accessing the Edit/Class Options dialog box can change the default 

penalty. 

The combobox labelled "Note" is for placing a note in the race result listing for a specific boat.  

The current choice of text that can be chosen is "Protest Pending" or blank.  Any other text can be 

entered for other messages.  Beware that this field is shown as a column in the race results and will 

take up valuable real estate on the printed output page.  The note will show in the finish list.  It can 

be changed or removed via the Edit>Finish Info é 

The next screen shot of the dialog box shows the configuration for a one design, rank by finish 

position. 
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The time control has been eliminated.  In the finish by position, there is also a check box to 

indicate a tie.  All boats that are considered to have crossed the line together will have the Tie 

check box ticked and they will be indicated in the list with an equal sign (=) following the numeric 

rank. 

In the following diagram, we have opened the Score Condition drop down to show the possible 

score conditions that can be chosen ï DNC, DNS, etc.  Boats not scored will be automatically 

scored as though they were DNC (did not compete). 

  

Once one race has been scored the results can be seen in the right hand list view.  Selecting the 

Overall node in the tree view will show a summary of the individual race scores, ranked by overall 

performance.  With only one race scored, this is somewhat uninteresting.  Now create more races 

and enter the results, checking with the overall score by clicking on the Overall node in the tree 

view.  The following shows the results of selecting the division A under the Overall node for the 

Ocean race class with three races in total. 



 28 

  

 

Editing the Results 

Editing the Information 

Once we have created a race class, entered divisions and scored a new race it usually becomes 

necessary to change things.  All the changes are placed under the Edit menu.  As nodes are 

selected in the left-hand tree menu, these operations will be enabled and disabled (greyed).  For 

instance, if the Overall view is selected, specific race conditions (start time, distance) cannot be 

edited since the race in question is not known.  An exception is if divisions need to be changed 

then the Enter/Change Any Divisions item of the Regatta main can be opened up and new 

divisions added or old divisions deleted.  The same applies to fleets.  If the division assignment of 

a specific boat or selection of boats is to be changed, select the boat or boats and use the Division 

Assignmenté under the Edit menu. 

 

Edit Regatta Information 

The following dialog box allows changing of the regatta information.  It is the same as the 

File/New menu item and any of the original fields can be modified here.  This dialog box shows 

the date picker when clicking on the arrowhead has dropped it down 
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Edit Class Information 

If this menu item is selected, then the same dialog as the Add Race Class menu item is opened up.  

In this case, the Scoring Method combo box and the Use Bow Numbers checkbox will be greyed, 

showing that it isnôt possible to change the scoring method once set. The other attributes, class 

name, drop percent, boat name checkbox, burgee image, email, web site and archive class 

database can all be changed.  If the OK button is pushed the currently selected race class will be 

rescored and the right hand view window  will be updated. 

 

Edit Boat Information 

If a boat is selected (row in the right hand list view window), then this menu item will be enabled.  

Selecting it will open up a dialog box similar to the boat register dialog box of Register Boats 

except that the Enter button is removed and the Close button is renamed as OK.  It is shown 

below. 
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There is no selection for the sail number.  In this dialog, any of the attributes of a specific boat can 

be changed, including the sail number, and on OK, the boat will be rescored (if the PHRF 

handicap has changed for instance) and the window display updated.  The edited sail number is 

checked for being unique within this race class.  If not unique, a warning message box is displayed 

so that it can be changed.  This figure shows the format of the boat dialog when entering 

information for a non-handicap race.  The PHRF box has disappeared. 

If a race is selected then, then the Fleet combobox will show the fleet that the boat had when that 

race was created or the boat information subsequently changed with that race selected.  Changing 

the fleet under this circumstance can change the scores since the individual Start scores will 

probably change.  In order not to change races already scored, itôs a good idea not to have a race 

selected when going to edit the boat information. 

A similar thing applies to the Handicap Change field.  If the race is selected and we are in a 

Handicap race class, then the Handicap Change box will be filled with the value that the boat had 

when the race was created or when the boat information was last edited.  Changes will go to that 

race.  Unless you really want to make changes to previous race boat conditions, itôs better to not 

have a race selected when editing the boat information. 

Again, the Bow Number field will be filled with the bow number associated with the boat unless a 

race is selected.  In this case, the bow number will be that associated with the boat in that race.  

When the OK button is hit, the bow number is tested for uniqueness within the boats in the race 

class but not for those within the race.  All the boats can have had their bow numbers changed 

since the race was created so it it possible to edit a boatôs bow number associated with a race and 

finish up with two bow numbers the same.  At the scratch sheet level when the race class node is 
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selected, the bow numbers are tested for uniqueness.  These are used whenever a new race class is 

created. 

Remember that the race remembers the fleet the boat was in (a possibly different fleet for each 

race), the Bow Number associated with the boat and also the Handicap Change that was used for a 

boat in that race. 

 

Edit/Copy 

Parts of a regatta can be copied to the clipboard where they can be merged with another regatta.  

The parts that are copied depend on what is selected in the left hand tree view.  At the top, if 

nothing appears selected, in reality the root node of the regatta is selected and everything will be 

copied.  At a lower level, choose a race class. Below this is the selection of a single race or the 

Overall node.  If the race class is selected then this and all the races contained will be copied.  If a 

single race, then just the one race will be copied.  If the Overall node is active, then no races will 

be copied; just the information on all the boats.  The copy essentially puts the contents of a .rcw 

file onto the clipboard. 

In addition you can select which boats to copy by making a selection in the right hand list view.  

This can be used to transfer the winning set of boats from an elimination into a separate winners 

race class and the losers into another. 

 

Edit/Paste 

Edit/Paste and the Tools/Merge are very similar.  Tools/Merge requires the specification of a 

regatta file, an .rcw file.  The Edit/Paste menu item is only activated when a Regatta item is on the 

clipboard.  The only way to get such an item on the clipboard is to do the Copy/Paste. 

 

Edit/Select All 

Edit/Select All will highlight all the boats in the right-hand list view. This is a short cut to replace 

clicking on the first boat in the list and then scrolling to the end and Shift-Clicking on the last 

boat.  A number of menu actions operate on a selection of boats. 

 

Edit Race Information 

In order for this menu item to be enabled, we must have a race selected in the left-hand tree.  

Selecting this menu item will open up the following dialog box. 



 32 

  

We can change wind speed and direction directly.  If the race class is for timed races, start times 

and distances of any of the predefined divisions are changed by selecting (clicking on) a row in the 

division list view. If a division doesnôt show up in the list, you should go back to the Enter/Change 

any Divisions é and make sure the box for "Has Start Time and/or Distance" is checked.  The 

time and distance will be transferred to the bottom fields where they can be changed.  The Apply 

button will transfer the modified values back to the list view so that one of the other divisions can 

also be changed before the dialog is dismissed by the OK or Cancel buttons.  The race name, 

description, comment fields and check box settings can also be modified from this dialog. 

It is possible that a race has to be inserted at a different position (usually because of mistake in 

entering the races).  In this case, add a race at the end.  Then edit the race and change the sequence 

number by entering the new position in the edit field in the bottom right hand corner. 

With a Pursuit race class, there is a checkbox labelled "Keep Start Times."  Unless this box is 

checked, whenever the race or division start times or distances are changed, the start times will be 

recomputed to match.  However, if a race is already underway and it becomes necessary to shorten 

the course, it will be impossible to score the race if the start times inside the program were to 

change. 

 

Edit Start Information 

If the start node under the race is selected then the "Edit Start Infoé"  item under the Edit menu is 

enabled.  Selecting this opens up the following dialog box. 
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This is the same as the dialog that creates the start.  Text printed with the start can be changed and 

the fleets associated with the start can be changed.  When the fleets are changed, no  warning is 

given even though the score of an existing race will change.  This is because it is so easy to go 

back and fix the problem.  Removing a fleet from a start will move it to a dummy unassigned fleet.  

This dummy start will also have a first, second, third, etc. so the effective result will be three 

firsts, three seconds, etc. 

 

@Edit Group Information 

If a group has been formed, the scores within the group can be changed with this dialog.  The 

dialog is identical to that produced when the race group is formed.  Multiple rows can be selected 

and all the selected scores changed with the Apply button.  Clicking on the column headers will 

sort the boats into order in the usual fashion.  This is the only way you can affect an individual 

boats score, other than through the Override Score (RDG) mechanism. 

 

Edit Finish Information 

In order for this menu item to be enabled, we must have a race selected in the left-hand tree view 

and a specific row selected (boat) in the right-hand list of results.  The dialog box that results 

depends on whether the race is a timed race or one scored by finish position.  For a timed race, the 

following dialog box is popped up. 
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This lists the race number and the sail number of the boat.  Finish date, time and penalties can all 

be selected and on dismissing the dialog with OK, the overall scores will be recalculated.  The 

New Position edit box shows the position at which the original time was entered.  A timed race 

will have the rank determined by the corrected time.  This position allows a change to match what 

are usually hand written sheets, in time order, and can be used for checking the entries into the 

scoring program against the on-the-water raw results.  Penalties can be selected from the drop 

down list labelled "Finish Condition."  This example shows a Black Flag disqualification being 

applied.  For a race scored by finish position, the following dialog box is displayed. 

  

In this we can enter a different finish position for this boat or select a different finish condition 

(DNS, DNF, DSQ, etc).  The drop down combo box rows are the same as shown in Enter Finish 

Information . 

In both these dialog boxes is a Note combobox.  Any text in this box can be removed by selecting 

the empty line.  The text can also be changed to any other text string.  As mentioned in entering 

the finish info, donôt make this string too long since it appears as a separate column when the race 

results are printed. 

On pushing OK (or hitting Enter), all boats affected by the new position or time will be rescored 

and a new overall score will be recalculated. 
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Override Score 

After the race, it is sometimes necessary to change the points awarded for one or more boats in a 

race.  This goes under the general heading of redress given (RDG flag).  This menu item is only 

enabled when a race is selected in the tree view and a row for a boatôs result is selected in the right 

hand list view.  If this is selected, the following dialog box is popped up. 

  

The box will show the current score for this boat.  If the score has already been overridden in 

error, then the effect can be removed by selecting "No RDG override" from the drop down list.  

Any score entered for redress will apply to all divisions.  If you have to change a number of boats, 

use the Ctrl-R accelerator key. 

This combobox the first time will show "No RDG Override."  There are five  types of override.  

First a simple score (RDG), second an average of all scores excluding overridden scores (RDGa) 

and third, an average of all scores excluding overridden scores up to the race in question (RDBb).  

The choice of which override to employ is via the dropdown box.  The choices are shown in the 

following repeat of the Override dialog box but with the drop down choices shown 

Other forms of override are the ARB and PTS lines .  These act in an identical fashion to the RDG 

selection but with the score being modified by ARB or PTS characters instead of RDG.  The 

intention of this is to allow the jury to apply penalties but not describe them via redress given 

(RDG) since itôs not really a redress.  ARB is for a score arrived at through arbitration and PTS 

stands for any points penalty. 

  

With RDG alone chosen, then the score to use must be entered in the edit box below the 

combobox.  With the averages, the scores are will not be known until the Overall node is selected 

to show the results.  The RDGa average is often used for compensating skippers who have to serve 

for one or more occasions on the race committee.  In this case they will receive the average of 

their results in the other races.  There is one other flag that controls how this is handled.  Under 

Edit>Class Options, we can set a flag that will include the DNC scores in the average.  This is not 

very favorable to the race committee and it would seem that their average should be only from the 

races that they actually sailed in and not be penalized for the times that they didnôt show up 

(scored DNC.) 

Itôs possible to choose an impossible condition.  i.e. Choose an average when there is only one 

race or average of races before the race in question when this is the first race.  If this is the case, 

when the Overall node is selected, a message box will be popped up saying "There are insufficient 
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scores to average for the boat with sail number "nnn" in race number 1."  The score will then be 

listed as "??? RDGa" or "??? RDGb" in the race column. 

If there is to be a hole in the scores where the original boat was placed, just use the override 

directly.  If there is to be no hole in the scores, the boat will first have to be given some finish 

condition that will move it to the end. For instance consider a 80 boat fleet.  The boat that finished 

in 20
th
 place is to be given a penalty of 8 places but without leaving a hole for score 20.  To do 

this, first score the boat in 20
th
 place RAF.  This will move it to the end and the boats in position 

21 and higher will be moved up, so filling the hole.  Now select the boat and override its score.  

Choose 28 for the score and the ARB qualifier.  The boat will now be listed with a "28 ARB" line 

in both the single race results and the Overall printout.   Note here that there will be two boats with 

a score of 28. 

If the override is removed, then the original score will be restored.  Beware though that you may 

have moved the boat arbitrarily to the end to remove the hole in the scoring.  In this case, the score 

will revert to the one you used to move the boat to the end. 

 

Edit Division Assignment 

A faster method of changing division assignments is the Division Assignmenté menu item under 

the Edit menu. This will only be enabled when one or more boats are selected in the right hand list 

view. When this menu item is chosen, the following dialog box is popped up: 

  

The number of boats selected will be listed at the top of the dialog box. On the left is a list of all 

the divisions defined for this race class.  On the right is a list of all the divisions used by the 

selected boats, which may be empty.  Any divisions listed here will have a count of the number of 

the boats in the selection that are members of the division.   Normally, boats belonging to a single 

division would be selected so that the count of boats for this division would be the same as the 

count of selected boats.  The example shown however is where eight boats have been selected, six 

of which are in division A and two of which are in division B.  There are only two divisions 

defined for this race class, A and B. 

If we select the A row from the Divisions list, the Add button will be enabled.  Pushing this will 

make all eight boats in the selection belong to division A or in effect, the two boats belonging to 

division B will now also belong to division A.  It is fine for a boat to belong to more than one 

division as long as only one has a start time.  These could be something like Masters, Women, 

Under16, etc. 
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If we select the B row from the list "Used by Selected Boats," the Remove button will be enabled.  

Pushing this will remove the B division from all the selected boats (two boats in this example) and 

the line will disappear since no boats (in the selection) are now in this division. 

Large numbers of boats can be moved in and out of divisions by this mechanism.  Remember, the 

boat list can be sorted by clicking on the column headers.  Selections can be extended by click 

once on the first row and Shift-Click on another row will select all the rows in between.  Control-

Click can be used to toggle the selected state of individual rows in the boat list.  Optimist fleets 

can be assigned by birthday.  Sort the class by birthday and then select all the entries that fall 

within the ages for a specific division.  Assign all these to the appropriate division, red, blue or 

white.  Note Optimists use Fleet for the different colors.  RaceSail uses fleets for sets of boats that 

have different starts within a race class ï usually only for splitting large entry fields into 

manageable starting lines. 

 

Edit Fleet Assignment 

The fleet assignment can be changed for selected boats, either for one of the races already created 

or one coming up.  In order to enable the menu item, a boat selection must be made.  If the menu 

item is selected, the following popup dialog box is seen. 

  

For  this we have selected all the boats with an Edit/Select All. The dialog shows that there are 53 

boats selected and of those boats, 14 are in the Brown fleet and 13 in each of the other fleets.  The 

normal use of the Select All action is to reassign the boats in the evening after a days racing.  If the 

boats are sorted into overall place order (just select the Overall node in the tree) then pushing the 

Sequential button will run through the boats assigning them in sequence to the fleets (in this case 

four fleets) as they come up. The assignment sequence as specified in the ISAF sailing instructions 

is 1, 2, 3, 4, 4, 3,  2, 1, 1, 2, é for a four fleet race class.  This will separate the top sailors for the 

races the following day.  Remember that before you do the selection, boat order can be changed by 

clicking on the column header to sort by that column.  If you want to assign to fleets by birthday, 

sort the boat list by birthday, select all the boats and then use the Edit Fleet Assignmenté dialog 

to assign the fleets to the boats in sequence.  Selecting a fleet and then pushing the Add button will 

remove all the other fleets and then assign the selected fleet.  Unlike divisions, a boat can only be 

in one fleet at a time. 
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Delete Boats 

If there are too many boats, selected ones can be removed.  For this menu item to be enabled, the 

Race Class node itself must be selected in the tree view on the left.  You canôt delete individual 

boats from a separate race.  With the race class node selected, select the boats to be removed in the 

right hand list view window.  Multiple selections are allowed.  This feature is intended for the 

adjustment of a cloned race class produced from Copy/Paste or Tools/Merge where too many 

boats are inserted into the original class. 

 

Delete Node 

If a node is selected in the tree view, then this can be deleted.  It is not possible to delete the 

Overall node for a race class since this is created automatically.  Be careful if the selected node is 

the race class since then all the registered boats and all the results will be removed ï after a 

prompt, if there is more than one boat in the class. 

A single race or the entire race class itself can be deleted in this fashion. 

Before making significant changes to a race class, it would be as well to backup the file.  

Everything in a Regatta is stored in a .rcw file and it is this file that needs to be preserved if there 

is ever a need to backtrack to a prior dataset. 

You can do a File/Save Asé to put the file somewhere else.  Just remember that this will change 

the default file for a subsequent File/Save to that location. 

 

Race Class Options 

When the Add Race Class menu has been completed then a class node will be added to the regatta 

tree in the left-hand window.  Select this node and the Class Optionsé item under the Edit menu 

will be enabled.  Choose this menu item and a similar tabbed dialog box to the Preferences 

referred to previously will be displayed except that it will tell you which race class is being edited 

and the Series Scoring check box will be enabled.  The following shows that the Series Scoring 

box has actually been checked and a minimum number of six races must be sailed in order that a 

boat may be scored. 
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In this, you can set the general buttons for the class specific conditions.  These are as follows and 

are further described under Preferences: 

Use Division Scoring, Use Bonus Point Scoring, Series Scoring, Average Scores, Use All Final 

Races in Tiebreaker, RDG Average includes DNC, ICSA Sailing Rules, Print DNC Boats, Score 

0.75 for First, Correct to Scratch Boat. 

The other tabs control the count function (registered or competing boats) and added integer for the 

special scoring conditions.  Change these for the race class selected in the tree view on the left-

hand window.  These options can be changed at any time and the class will be rescored with the 

new conditions. The description for these scoring codes is given here. Note that the Clubs, Types 

and Colors tabs have been removed since these are functions that should only be done at the 

administrator level for any race class that is going to be created and have boats registered in the 

future. 

 

Seeing the Results 

Preparing Scratch Sheets 

If the Race Class node itself is selected in the right hand tree view, the boats in the race class will 

be listed on the right with crew (if necessary), hull color, spinnaker color, PHRF, etc.  The 

window will look like the following: 
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Selecting File/Print Preview will show the following window where the boats are listed 

corresponding to the information in the right hand list view window. 

  

At the bottom of the listing, there is the minimum count in characters (taken from the right) for a 

unique sail number.  This means that the committee boat only need to record the last two digits of 

the sail numbers to be assured that the boat is uniquely identified.  This shortening of the sail 

number recording can make it easier when scoring many boats crossing the line at the same time 

and with all boats using six or seven digit sail numbers. The count is calculated from all the boats 
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in the race class, not just those of a single division, since they will all probably be crossing the 

same line to finish. 

When many races and/or race classes are part of a regatta, it will save time to use the Print Scratch 

Sheetsé line under the File menu. The action of this command depends on which node is selected 

in the tree view. If the top Regatta node is selected, then RaceSail will descend the tree, visiting 

each node in turn and if appropriate, will then print out the scratch sheets. If the scoring method is 

one design, finish by position, then the scratch sheet is the listing of boats from the main race class 

node. Divisions are not listed separately.  If the scoring method implies time, then each race, and 

usually division, will have a separate starting time and possibly distance. For this, each race node 

and child division node are visited separately and the race details and boats are printed out. 

If there is too much real estate being taken up on the printed page, columns can be eliminated from 

the output by dragging with the mouse the header box edge until the width is zero.  Unfortunately, 

this doesnôt work when a number of sheets are being printed together as in Print Scratch Sheetsé 

or Print Results.  The reason is that each column view is created and printed before there is any 

opportunity to change the column widths with the mouse. 

 

Individual Race Results 

If one of the Race nodes is selected in the tree (Race1, Race2, etc.), then the results of an 

individual race will be listed in the right hand window as shown below:  The Order column is the 

order in which the results are entered.  You may know that a boat is a DNF long before all the 

boats have crossed the finish line.  You donôt have to  wait until the end.  If you sort on the Order 

column (click on the column header) and print, the results will match the entry order and can be 

more readily checked. 
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The print preview will show a window like the following when the A division node is selected 

under Race 1: 


